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Start Up

Users use the browser (default IP: 192.168.168.10, account: admin, password:

IP585xAdmin), and the homepage provides links to AG300 related functions.

System login screen:
PEEH 192. 168. 168. 10

e~Gateway

APEW: (@ adnin v

T ©): [ |
AR R):

| mE || B

After successful login, the system will list the current status information, the page is as

follows:

Users can set the project into four major items: "Device info", "Settings", "wireless",

and "System Management".

Status Overview

System Info
Firmware Version
System Up Time
Host ID

WAN Network
Connected Type
WAN IP Address
Subnet Mask

Default Gateway

Primary Domain Name Server

Secondary Domain Name Server

MAC Address

Change Language» [SIEN E

IOMv2_XDAQE00_v1.2.0SX_r12345_2019-09-16
0 day 22 hours 7 minutes
1000.15.3777.334 808

STATIC
172.16.13.168
255.255.224.0

172.16.13.172

202.103.24.68

00:19:15:EC:28:24
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1. Device Info

The device information includes five items: "Status Overview", "DHCP Client List",

"System Log", "Change Setting Log", and "Device Alarm History".

1.1 Status Overview

Users can use this project to obtain basic system information and network settings.
The page is as shown in the figure above.

1.2 DHCP Client List

Users can use this project to obtain DHCP client data.

DHCP Client List

» Status Overview

You could monitor DHCP clients here.
» DHCP Client List

> System Log DHCP Clients

» Change Setting Log

» Device Alarm History

Hostname(optional)
HUAWEI_Mate_20_
HUAWEI_P20_Pro-
ATU-AL10-5ealct
MIBUD-xiaomisho

HUAWEI_MAIMANG_

MAC Address

AC92:32:23:C9:67
C4:9F:4C10:AEAD
T4:C1:4F:56:82:E2
A4:50:46:D8:4C:5F
84:9F:B5:AB:50:29
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IP Address

192.168.168.86
192.168.168.63
192.168.168.89
192.168.168 .42
192.168.168.36

Expires in
02:48:20
03:48:32
04:21:36
06:02:44
21:21:21
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1.3 System Log

Users can use this project to obtain system log data.

System L

> Status Overview
Check the system log

> DHCP Client List

> System Log

kernel: .328000] <==== rt28xx_init, Status=0
kernel: .332000] BBE ed monitor_exit : =
kernel: .336000] RRR ed monitor_exit : < =
kernel: .340000] mt7628_set_ed cca: TURN OFF EDCCR 1
kernel: .34B000] WiFi Startup Cost (ra0): 3.088s
kernel: .208000] device eth2 entered promiscucus mods
kernel: .740000] device ral entered promiscucus mode
kernel: .820000] device eth2.l entered promiscucus m
kernel: .572000] br0: port 2(eth2.l) entered forward
kernel: .580000] bro: port 2{eth2.1) entered forward:
kernel: .524000] br0: port 1({ral) entered forwarding
kernel: .588000] br0: port 1(ral) entered forwarding
kernel: .948000] PeerhssocRegSanity - IE_HT_CAP
kernel: 2.952000] PeerhssocReg3anity - IE_EXT_CAFABIL.
kernel: .976000] Rcwv Wecid({l) AddBAReq
kernel: .920000] Start Seqg = 00000004
kernel: .932000] Ring No 1
kernel: .932000] Ring No 1
1
1]

> Change Setting Log

> Device Alarm History

A R

a3 aaa

kernel: .9368000] Ring No
kernel: .938000] Ring No

RY ORI B3 ORI ORI ORY BRI ORD

3

1.4 Change Setting Log

The operation history is listed in the List directory. It can be exported via the "Export"
button.

Change Setting Log

> Status Overview

Export Log

> DHCP Client List
Export Button

> System Log

List

» Change Setting Log

> Davice Alarm History Time Operator Target Action
2016-01-01 00:11:31 Web FSito1 Add
2016-01-01 00-18-21 Web FrDik01 Edit
2019-11-27 14:24.18 Web ks Add
2019-11-27 14:31:02 Web other Add
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1.5 Device Alarm History

Users can use this project to view the alarm records of all devices.

Device Alarm History
> Status Overview
Motor
> DHCP Client List
Device Name Type Status Value Limit Time
> System Log 201910
Frh Acceleration | Sudden
» Change Setting Log 401 D RMS u 5.9330,2.600,829.0700,0.2630 800.0000 k3|
) . = : P 19:29:26
> Device Alarm History
— 2019-10-
S Acceleration | Sudden
K D 17.3730,2.000,838.6200,2 4665 | 800.0000 30
%01 RMS Up
16:20:59
— 2019-10-
RS Acceleration | Sudden
K D 12.1570,1.600,848.2300,0.7521 800.0000 30
%01 RMS Up
16:11:46
— 2019-10-
| Acceleration | Sudden
K D 9.6760,4.500,1740.9500,0.9115 | 800.0000 29
%01 RMS Up
16:03:33
— 2019-10-
s Acceleration | Sudden
K D 13.1940,4 400,1036 31001 0834 | 8000000 29
%01 RMS Up )
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2. Settings

Usage settings include "LAN", "WAN", "Unit Paring", "RS485", "Maintenance info" sub-

items.

2.1 LAN

Users can use this project to set LAN settings, the page is shown as below:

Change Language» [E=als]li=i] |Z|

Local Area Network (LAN) Settings

You may enable/disable networking functions and configure their parameters as your wish

> LAN
LAN Setup
> WAN

) N IP Address 192.168.168.10
> Unit Pairing

Subnet Mask 255.255.255.0
> RS485

) MAC Address 00:19:15:EC:28:22
» Maintenance Info
DHCP Type Server E|

Start IP Address 192 168.168.11
End IP Address 192.168.168.254
Subnet Mask 255.255.255.0
Primary DNS Server 192.168.168.10
Secondary DNS Server

Default Gatewa

2.2 WAN

Users can use this project to set up the WAN. The page is as shown below:
"Remote Access" can configure projects that allow remote access:
"Secure HTTP" can enable or disable remote HTTPS access

"Normal HTTP" can enable or disable remote HTTP access

"Remote Login" can enable or disable remote login
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Wide Area Network (WAN) Settings

You may choose different connection type suitable for your environment. Besides, you may also configure |-
> LAN parameters according to the selected connection type.
> WAN Wide Area Network (WAN) Settings
> Unit Pairing WAN Connection Type: STATIC (fixed IP)  [7]

> RS485
Static Mode

> Maintenance Info
IP Address 172.16.13.168
Subnet Mask 2552652240
Default Gateway 1721613172
Primary DNS Server 202.103.24.68

Secondary DNS Server

Vian ID

2.3 Unit Pairing

Users can register through the webpage, as shown below :

- EEmmE

Unit Pairing Information

Unit Pairing Information

> LAN Name Type IP Address

Last Register Time Status Select

> WAN Account Subtype MAC Address

Unit Pairing .

> RS485

» Maintenance Info
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1. Press the "Add" button to automatically create a new terminal device.

Change Language» [E=allE) E|

Unit Pairing Information

Unit Pairing Information

> LAN Name Type IP Address
Last Register Time Status Select
> WAN Account Subtype MAC Address
> Unit Pairing Smart Phone
XXX Smart Phone

Initial
» RS485

2. Check the newly generated terminal device, and press the "Edit" key to enter the
editing screen, you can edit the various information of the terminal device.
-Name: Fill in the appropriate name according to personal needs.
-Type: Smartphone.
-Account: Please enter the number within 100 ~ 109, and this number cannot be

the same as other registered terminal equipment.

-Password: can be reconfigured according to personal needs.

Change Language» =il |Z|

Edit Unit

Unit Information
> LAN

Name

>

e Type Smart Phone [~

> Unit Pairing
Account KXK

» RS485
Password KUK

» Maintenance Info E
MAC Address
IP Address

Status Initial
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3. After editing the information, press the "Save" button, and then press the "Start

Pairing" button to enter the device registration program.

Change Language » [=lgls|E=al E

Edit Unit

Unit Information
> LAN

Name 100
> WAN
Type Smart Phone E|
» Unit Pairing
Account 100
> RS485
Password 100
» Maintenance Info E
MAC Address
IP Address
Status Pairing

o [ S —

4. After successful registration, the status will show "Connected".

Unit Pairing Information

Name Type IP Address } }
Last Reqgister Time Status Select
Account Subtype MAC Address
101 Smart Phone 192 16B.0.1
2016-01-01 00:06:17 Connected
101 Smart Phone al:f4:50:c3:01:d5

- e 2 e
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2.4 RS485

Users can use this project to add equipment, set and view equipment parameters, and
configure the “Alarm Trigger Time” of the alarm and the “Start Address” of the
equipment.

Alarm Trigger Time

»
LAN Vibration Alarm Trigger Time ~ gp 5

» WAN
Kurtosis Alarm Trigger Time 60 5

» Unit Pairing

» Maintenance Info B Device Parameter

Start Address 30001 =]

Motor

Index Start Address Name Work ID Work Status | Select
1 30001 FDiE0 101 Stop @]

1>._ Add Motor :
1. Select the "Add" button in the motor, enter the configuration parameters, and click
"Save" to add a motor.

Motor

Name
Work ID
Voltage Y

&=  Current A
SPEC Power KW
Poles
Rotational Speed RPM
Frequency HZ
Power Frequency HZ
Efficiency 94
Frame Number -
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Some parameters are explained as follows:

Name: fill in as required

Work ID : Motor factory ID

Drive Mode : direct drive and inverter drive

Control point : Configure DO

FAE Information : Contact Information for Equipment Maintenance Personnel

Engineer Information : Factory Technician Contact

2. After adding the motor, you can add IEPE below.

Eearmg ”emgnatmn 100 .
Maintenance Hours 12000
Drive Mode Direct Drive E|
FAE Information There is not the FAE information
Engineer Information There is not the engineer information
Save
IEPE
. . ; CPU
Name Line HW Version SW Version
Temperature
Bl 1 1.0 1.0 38 W & U

3. Add an IEPE, select "+", and complete the IEPE setting in the pop-up box. Click the

"Save" button to save.
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MName

WVelocity RMS

Up Limit

Up Early WWarning
Lowy

High

Sudden Change

Some parameters are explained as follows:

Line : Choose to use the first set of lines (1) or the second set of lines (2)

Name : can be filled as required

Vibration

Name : fill in as required

Velocity RMS

Up Limit : When the vibration reaches this set value, an alarm will be issued. Please
fillin (mm / s) according to the specifications.

Up Early Warning : When the vibration reaches this set value, a warning
notification is issued. Please fill in (mm / s) according to the specifications.

Low : minimum vibration setting value, please fill in according to the specification
(mm/s).

High : The highest vibration setting value, please fill in according to the
specification (mm /s).

Sudden Change

Amplitude : Please fill in the value (mm / s) as required (if no value is filled in, this
function will be automatically turned off).

Time : Please fill in the value according to the requirements, the range is 5-60.
Acceleration RMS
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Up Limit : When this set value is reached, an alarm will be issued. Please fill in (mm
/ s?) according to the specifications.

Up Early Warning : When the set value is reached, a warning notification is issued.
Please fill in according to the specifications (mm / s?).

Low : The lowest setting value, please fill in according to the specifications (mm /
s2).

High : The highest setting value, please fill in according to the specifications (mm /
s2).

Sudden Change

Amplitude : Please fill in the value (mm / s?) as required (if no value is filled in, this
function will be automatically turned off).

Time : Please fill in the value according to the requirements, the range is 5-60.
Displacement

Up Limit : When this set value is reached, an alarm will be issued. Please fill in (mm)
according to the specifications.

Up Early Warning : send pre-warning notice when reaching this set value, please fill
in (mm) according to specifications.

Low : The lowest setting value, please fill in (mm) according to the specifications.
High : The highest setting value, please fill in (mm) according to the specifications.
Sudden Change

Amplitude : Please fill in the value (mm) as required (if the value is not filled in, this
function will be automatically turned off).

Time : Please fill in the value according to the requirements, the range is 5-60.
Kurtosis

Up Limit : When this set value is reached, an alarm is issued.

Up Early Warning : A warning notification is issued when this set value is reached.
Low : The lowest setting value.

High : The highest setting value.

After adding, you can click the configuration icon to modify the parameters of IEPE.
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IEPE
. . . CPU
MName Line HW Version SW Version
Temperature
Eigijll 1 1.0 1.0 38 e

-+ 9]

IEPE

Sensitivity 100

Mode Maormal E
Sampling Rate 1BKHZ [~ ]
High-Pass Frequency 10

Low-Pass Freguency 1000

FET Window Kaiser-Bessel[~]

Start Freqguency

Stop Frequency
Step Frequency

Yelocity Gain

4. XDAQ600 (P) additionally contains PMS related setting parameters, as shown

below :
Sample Number 8192
Sample Rate | 16000
Rotation Rate 1800
Threshold | 10
Ball Diameter | 0
Bearing Pitch 0.001
Ball Mumber 0
Contact Angle | 0
Inner Freguency | 0
Outer Freguency 0

Roller Frequency 0
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Rotor Number
Gear Frequency
Gear Number
Low Frequency

High Freguency

Cancel

1000

4000

Save

PMS parameters are described as follows :

Field

Description

Sample Rate

Keep it the same as DAQ setting

Sample Number

Keep it the same as DAQ setting

Fa (Spinning) in RPM

Motor spinning speed in RPM

Threshold

There are 17 known defects. The application will
calculate the confidence level of each defects. Only
when the confident level > Threshold will be shown in

the diagnosis information field.

Contact Angle

Contact Angle

Bearing Diameter

The theoretical median diameter of a bearing, which

passes through the center of the balls.

Number of Balls

Number of balls

Ball Diameter

Diameter of balls

Inner Frequency

Ball Pass Frequency of Inner Ring

Outer Frequency

Ball Pass Frequency of Outer Ring

Roller Frequency

Ball Spin Frequency

Number of Rotors

Number of rotor bars in a motor

Fp(Driven Gear)

The output speed of a gear box
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Number of Gears The number of teeth of first driven gear.
Low frequency Ignore frequency lower than low frequency
High frequency Ignore frequency higher than high frequency

Note : The PMS parameters are supported for xDAQ-600 (P) only.

2>. Add the switchgear:
1. Select the "Add" button in the switchgear, enter the parameter configuration, and
click "Save" to add a switchboard.

Switchgear ‘

Switchgear
Name
Work ID
Voltage ")
Current A
Frequency HZ
Phase
FAE Information There is not the FAE information
Engineer Information There is not the engineer information

PN
Save

3>. Add other devices:
1. Select the "Add" button in other devices, enter the parameter configuration, and
click "Save" to add another device.
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Other Device
Other Device |
MName
Work ID
Voltage v
Current A
Frequency H7
Phase
FAE Information There is not the FAE information
Engineer Information There is not the engineer information

Save

2. After adding other devices, you can add IEPE below.
W‘

Frequency 223 HZ

Phase 23 -
FAE Information There is not the FAE information

Engineer Information There is not the engineer information

Save

IEPE

CFU

Temperature

Mame Line HW Version SW Version
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2.5 Maintenance Info

Users can use this project to add contact information of equipment maintenance

personnel and factory technicians.

:

Maintenance Information

FAE Information

>LAN Name Phone Number Select

> WAN p . L .
S S

Engineer Information

> Unit Pairing

» RS485
Name Phone Number Select

O S

> Maintenance Info

1. Click "Add", enter name and phone number, save and add a contact.

ULUEGERE English E

Maintenance Information

Name 123

> W,
b Phone Number 123456789

> Unit Pairing

> RS485

> Maintenance Info
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2. After checking the contact list, click the "Edit" or "Delete" button to edit or delete a

record.

W Maintenance Information

FAE Information

> LAN Phone Number Select
> WAN 123 123456789

2 Peirng S

> RS485

Engineer Information

> Maintenance Info
Name Phone Number Select

requUEncy 50

Power Frequency

50

Efficiency

99

> LAN

Frame Number 230

> WAN

Bearing Designation 100

> Unit Pairing

Maintenance Hours 12000

» R5485

Drive Mode Direct Drive E

> Maintenance Info

FAE Information 123(123456789)

Engineer Information 456(123456789)
Save
IEPE
CFU
Name Line HW Version SW Version
Temperature

AL
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3. Wireless

First, set the wireless mode on the "WiFi Mode Setting" page. The menu options on

the left will be different under different wireless modes.

3.1 WiFi Mode Setting

Users can use this item to set the wireless mode: wireless hotspot (AP) mode or

wireless hotspot + client (AP + STA) mode.

When the XDAQ-600 is in the wireless hotspot mode, other wireless clients (including
mobile phones) can log in to the XDAQ-600 webpage through WiFi to configure the
XDAQ-600.

When the XDAQ-600 is in the wireless client mode, the XDAQ-600 itself can be used as
a wireless client to connect to other wireless access points (including the 4G wireless
router inserted on the XDAQ-600).

Please note: Switching between the two modes requires restarting the XDAQ-600.
English B

W WiFi Mode Setting

WiFi Mode Setting

Operation Mode AP Mode [v]
= AP Mode
> WiFi Mode =AP+STA Mode |

e

> Basic
> Advanced
> Security

> Station List
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3.2 Basic Wireless Settings

3.2.1 Basic Settings

This item allows users to set the most basic settings for wireless communication in
wireless hotspot mode, such as network name, network mode, etc. WIFI is enabled by
default. The page is shown below :

Change SCOl English |Z|

Basic Wireless Settings

You could configure the minimum number of Wireless settings for communication, such as Network
Name (SSID) and Channel. The Access Point can be set simply with only the minimum setting items.

> WiFi Mode Wireless Network

» Basic WiFi Enable

> Advanced - Network Name(SSID) Tecom_EC2824

> Security Network Mode 11b/g/n mixed mode =]

> Station List Frequency (Channel) 2412MHz (Channel 1) [=]
Broadcast Network Name (SSID) Enable E|

AP Isolation Disable[~]

BSSID 00:19:15:ec:28:22

Cancel

After modifying the settings, click Apply and wait for about 10 seconds without

restarting.

3.2.2 Advanced Settings

Users can use this item to set advanced parameters of wireless network in wireless
hotspot mode, such as transmit power, country and region, and support channels.
Wait for about 10 seconds after clicking Apply without restarting.
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Change Language»

Advanced Wireless Settings

Use the Advanced Setup page to make detailed settings for the Wireless. Advanced Setup includes tems
that are not available from the Basic Setup page, such as Beacon Interval, Control Tx Rates and Basic
Data Rates.

> WiFi Mode

. Advanced Wireless
> Basic

TX Power (range 1 - 100. de
N . 100 (range 1 - 100, default 100

. Country/Region NONE
> Security el =

» Station List Support Channel Ch1~13 [7]

o

3.2.3 Security Settings

Users can use this item to set up wireless security and encryption in wireless hotspot
mode to prevent unauthenticated devices from accessing and monitoring. The mode
has two options: off and WPASKWPA2PSK. The default is off. After selecting
"WPAPSKWPA2PSK", set the WPA parameters below.

E=EE

Wireless Security/Encryption Settings

Setup the wireless security and encryption to prevent from unauthorized access and monitoring.

Security Policy

s WiEi
LA LN Security Mode WPAPSKW'PAZPSK

> Basic
WPA
> Advanced

WPA Algorithms TKIPAES E

> Security
Pass Phrase

> Station List
Key Renewal Interval seconds (0 ~4194303)

o
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Set the WPA algorithm, password and key update interval. After saving successfully,
the client needs to fill in the password set here when connecting to WIFI.

3.2.4 Station List

Users can use this project to monitor clients connected to XDA-Q600 in wireless

hotspot mode.

Station List

You could monitor stations which associated to this AP here

Wireless Network

> WiFi Mode MAC Address Aid PSM MimoPS MCS = BW e
> Basic 60F81D2B20FA 1 0 0 0 20M 0

> Advanced
> Security

> Station List

3.3 AP+STA Mode
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Change Language» SISl B

S Bevceo R iy ode Setting

WiFi Mode Setting

Operation Mode AP+STA Mode[~]

> WiFi Mode

> Basic

> Advanced

> Security

> Station List

> AP Client Link Status
> AP Client

When the XDAQ-600 is in the wireless hotspot + client mode, you can first find the
available wireless hotspots by scanning the hotspot (such as inserting the 4G wireless
network card of the XDAQ-600).

3.3.1 Scan nearby hotspots

Change Language, [sals|[EIaNEA

AP Client Feature

You could configure AP Client parameters here.

AP Client Parameters

> WiFi Mode
SSID

> Basic
MAC Address

> Advanced

Channel

> Security

> Station List Security Mode OPEN v

> AP Client Link Status Encryption Type None

> AP Client

Site Survey

SSID BSSID Secure RSSI Channel
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e Languages

Site Survey

Ss5ID BSSID Secure RSSI | Chan
> WiFi Mode Xiaomi_111 f0.b4:29.30.5.94 | WPA2PSK/AES 100%
> Basic CloudR 28:10.7b:54:63:96 | NONE 100%
> Advanced Tenda_Teony c8:3a:35:2e:bb:68 | NONE 100%

> Security Tecom_D088D9 00:19:15:d0:88:dV | WPATPSKWPAZPSK/TKIPAES | 100%
TP-LINK_SmartGateway b0:48:7a:2e:73:5c | WPATPSKWPA2PSK/AES 96%

> Station List
FAE_new bc:46:99:60:93:98 | WPATPSKWPA2PSKIAES 96%

Sl e e e Vinson-test 00:0d:f0:8a:ab:70 | NONE 96%

> AP Client VRA081W2 00-0d-f0:8a:ab-71 | WPA2PSK/TKIP 96%
DIR-816-5K2 10:be:f5:73-7b:10 | WPA1PSKWPA2PSK/TKIPAES
TP-LINK_Ethan 88:25.93.de-bbice | WPA1PSKWPA2PSKIAES

xuanyuan c8:3a:35:34:f4:78 | WPAPSK/AES

Select a hotspot, and the wireless client parameter section will be filled in
automatically. If a password is set for this hotspot, please enter the password in the

"Password" input box, and then click the "Apply" button.

You could configure AP Client parameters here

AP Client Parameters

SSID Xigomi_111

> WiFi Mode
MAC Address f0:b4:29:30:e5:94

> Basic

Channel
> Advanced

> Security Security Mode WPAZPSK ¥

» Station List Encryption Type AES v

> AP Client Link Status Pass Phrase

> AP Client

Site Survey

BSSID Secure RSSI | Chan

A0 BN AE -0 A WWDANDEWIACS A NN0L 1 M
»
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Change Language»

You could configure AP Client parameters here
AP Client P

SSID

> WiFi Mode
MAC Addres

> Basic

Channel
> Advanced

> Security Security Mode WPAZPSK v
» Station List Encryption Type AES v

> AP Client Link Status Pass Phrase 123456789

> AP Client

Site Survey

SSID BSSID Secure RSSI | Chan

- Vimmmai A44 A A0 DN AE DA WIDANDEWIACS 4NNoL 1 M

»

After a while, if you want to know if the connection is successful at this time, you can
visit the Connection Status page.

3.3.3 Connection Status

Change Lal Bl English E

AP Client Link Status

Link Status

Status Connected

» WiFi Mode SSID Xiaomi_111
. BSSID f0:b4:29:30:e5:94
> Basic
IP Address 10.0.2.10

> Advanced
Net Mask 255.255.255.0

> Security - GateWay Address 10.022
> Station List

> AP Client Link Status
> AP Client
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4. System Management

The system includes "Basic Settings", "Configuration File", "Certificate Update",
"Firmware Update", and "Log Level".

4.1 Basic Settings

Users can use this project to set basic settings, including remote tool settings,

language settings, adminstrator settings, user settings, network time settings, and
network ID settings.
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Change Languagey

Basic Settings

You may configure account and password, NTP settings, and Dynamic DNS settings here.

Remote Tool Settings
Customer Key

» Basic Settings Active Mode Forever v

> Configuration File > Status Inactive

> Firmware Update

Language Settings
> Log Level

Select Language English v

Adminstrator Settings

4.2 Settings Management (Configuration File)

Users can use this project to export system settings files for saving system settings,
import configuration files to restore the system, and restore system factory settings.
The page looks like this :

Change Language» (sl |Z|

Settings Management

You might save system settings by exporting them to a configuration file, restore them by importing the
file, or reset them to factory default

Export Settings

> Configuration File B Import Settings

> Certificate Update : Settings file location .

» Firmware Update

> Log Level
Load Factory Defaults

Keep Settings MNone E

Load Default Button Load Default

Import Common Settings
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The "Keep Settings" option is used to set the settings that the system needs to retain
when restoring factory settings, including the WAN and account.

The "Import Common Settings" function is used for batch configuration. If an xDAQ-
600 is configured, download its configuration file, and then upload it through this
function on other xDAQ-600 pages, part of the configuration file of other xXDAQ-600
will be synchronized with the configured xDAQ-600.

4.3 Certificate Update

Users can use this item to set APNS certificate, import and configure APS client.

Change Language,» [RSalvE=aE.

Certificate Update

APNS Certificate Setting
Name
Private key password
> Basic Settings

> Configuration File

® Import APNS Certificate

> Certificate Update

> Firmware Update Certificate file location e | SR RIS

APS Client Setting

Enabled Enable v

Server URL apns.tecom.com.tw

4.4 Firmware Update

Users can use this project to upgrade the xDAQ-600 firmware. The page is as shown
below :
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Firmware Update

Upgrade the new firmware to obtain new functionality. It takes about 2 minutes to update firmware and be

patient please. Caution! A corrupted image will hang up the system.

Firmware Updating

Firmware location FEL ..
» Basic Settings

Apply
MCU Updating

» Configuration File

» Certificate Update

MCU firmware location Hl. ..

oy e

» Firmware Update

» Log Level

Reboot

4.5 Log Level

Users can use this project to set the log level.

After setting the log level and output target for a certain item, you need to click

"Change Priority" to take effect.

If you want to output logs to a file, you need to set the file size. First click "Change
Priority" and then click the "Download" button to download the log file.
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e Language

Log Level

Set Indoor Private Protocol ¥ |log levelto) None ~

log destination to| Serial ¥

T e

i i Log L | List
> Basic Settings og Level Lis

. . Application Name Log Level Log Destination log size
> Configuration File P E ¢ ¢

Indoor Private Protocol Error Serial 0 KB

> Certificate Update :
Web Error Serial 0 KB

> Firmware Update Launcher Error Serial 0 KB
> Log Level Monitor Error Senal 0 KB
System Manage Error Serial 0 KB

APS Client Error Serial 0 KB

Long Tooth Error Senal 0 KB

Modbus Server Error Serial 0 KB
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